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1. Введение 

Документ предназначен техническому персоналу, обслуживающему систему SI2000 V5 версии 
программного обеспечения LS5072AX и LS5073AX в дублированных, недублированных модулях MLC, 
а также 1U. 
 
В документ входят разделы, описывающие как ежедневные процедуры технического обслуживания, 
так и процедуры, выполняемые в случае отказов работы системы, т.е. в экстренных ситуациях.  
 
Особенно важными являются главы 13 и 14, где описаны процедуры, которые персоналом по 
техническому обслуживанию должны производиться регулярно, чтобы предотвратить потерю 
тарифных и полупостоянных данных (SPD) в базе данных MN. 
 
В документе использовано сокращение MN, которое обозначает централизованный узел управления 
(management node), представленный стационарным компьютером. MT (management terminal) � это 
портативный персональный компьютер (notebook PC) для проведения оперативных действий в 
экстренных ситуациях непосредственно на объектах.  
 
В тех случаях, когда персонал по техническому обслуживанию не может самостоятельно решить 
возникших на объекте проблем, или в процессе работы появляются затруднения, можно обратиться 
за помощью в службу технической поддержки Iskratel. Свяжитесь с оператором Нelp desk удобным 
для вас способом: 
 
телефон:  +386 (0)4 207 3476 
телефакс:  +386 (0)4 202 2595 
электронная почта:  helpdesk@iskratel.si 
 
Время работы с понедельника по пятницу с 7.30 до 15.30. 
 
Для решения вопросов, не терпящих отлагательства, предназначена дежурная служба технической 
поддержки. 
 
Дежурный телефон: +386 (0)40 273 901 
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2. Установка и использование консоли и сети  

2.1. Сетевые установки и подключение 

2.1.1. Сетевые установки на MN, MT 

Зарегистрируйтесь на MN, MT в качестве mnadmin-пользователя. В меню Start -> Setings откройте 
окно Control Panel. В нем откройте окно Network и нажмите кнопку Protocols. Отметьте TCP/IP Protocol, 
после чего нажмите кнопку Properties. 
 
Откроется окно Microsoft TCP/IP Properties, в котором введите IP-адреса (IP Address, Subnet Mask, 
Default Gateway). IP-адреса определены проектно.  
 

 
 

При внесении любых изменений сетевых установок необходима повторная загрузка (reset) 
компьютера.  

2.1.2. Сетевое подключение к модулю MLC 

2.1.2.1. Недублированный модуль MLC 

Сетевой кабель UTP подсоединяется к верхнему (из трех) разъему RJ45, находящемуся на нижней 
части съемной платы CLC. Верхний разъем предназначен для сетевого подключения, средний - для 
подключения RS232 PPP-соединения MPS.  
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2.1.2.2. Дублированный модуль MLC 

В дублированной системе (модуль с двумя съемными платами CLC) сеть (сетевой кабель UTP) 
подключается только на одну из этих плат. Для дублирования используется специальное выполнение 
платы CLC. Сетевое соединение между съемными платами CLC идет через внутренние сетевые 
соединения непосредственно на съемной плате и через заднюю плату. 
 
Сетевой кабель UTP подсоединяется к верхнему (из трех) разъему RJ45, находящемуся на нижней 
части съемной платы CLC. Верхний разъем предназначен для сетевого подключения, средний - для 
подключения RS232 PPP-соединения MPS. 

2.1.2.3. Модуль 1U  

Сетевой кабель UTP подключается к разъему RJ45, обозначенному  ETH/1, находящемуся на 
лицевой панели модуля. 

2.2. Установки на консоли и подключение  

2.2.1. Установки на консоли 

На MN, MT зарегистрируйтесь в качестве пользователя sysadmin. Для консоли обычно используется 
программа Programs -> Accessories -> Hyperterminal -> HyperTerminal. Параметры определяются с 
помощью меню File -> Properties. Откроется следующее окно: 
 

 
 

Выберите тот последовательный порт на MN, MT, к которому был подключен кабель консоли. Для 
установки оставшихся параметров консоли откройте новое окно с помощью кнопки Configure. 
Откроется окно, изображенное на следующем рисунке. В нем отображены необходимые установки 
консоли: 
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2.2.2. Подключение консоли к модулю MLC и 1U 

Кабель консоли разрешается подключать только в процессе локального вмешательства, проводимого 
на плате CDB. По окончанию действий кабель необходимо отключить. 

2.2.2.1. Подключение консоли к модулю MLC 

Консольный кабель на материнскую плату CDB (master, slave) подключается через RS232 с помощью 
разъема RJ45 на материнской плате KDB ETN5022. 

2.2.2.2. Подключение консоли к модулю 1U  

Доступ к платам CDB (master, slave) в корпусах 1U возможен через RS232 разъемов RJ45 на лицевой 
стороне корпуса 1U. Эти разъемы обозначены как RS232/1 (доступ к master CDB) и RS232/2 (доступ к 
slave CDB). 
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3. Процедура сброса и выключения модулей MLC и 1U 

Перед проведением определенных процедур, например, перед изъятием съемных плат CLC и PLC, 
необходимо выключить модуль MLC. После выполнения некоторых административных процедур 
необходимо провести сброс (reset) модуля MLС и 1U, т.е. выполнить повторную загрузку 
программного обеспечения и базы данных. Далее дано описание правильной процедуры сброса 
(повторной загрузки) и выключения модуля. 

3.1. Сброс (Reset) и выключение недублированного модуля MLC 

3.1.1. Сброс (повторная загрузка) недублированного модуля MLC 

Выполняется одно из следующих действий: 
• В MN, в окне Management Login � System Management выберите соответствующий модуль в 

режиме Read/Write и выберите команду Administration -> Node Restart, на вопрос ответьте, 
нажав кнопку Yes. 

• На системной консоли платы master CDB дайте команды: 
pSH+> sync 
pSH+> reset  

• Выключение модуля произведите с помощью выулючателя вкл./выкл. на съемной плате PLC и 
через несколько секунд включите снова. 

3.1.2. Выключение недублированного модуля MLC 

Модуль MLC выключите с помощью выключателя вкл./выкл. на плате PLC. Система перед 
окончательным выключением питания произведет закрытие файловой системы автоматически. 

3.2. Сброс (Reset) и выключение дублированного модуля MLC  

3.2.1. Сброс (повторная загрузка) дублированного модуля MLC 

Выполните одно из следующих действий: 
• Переключение (reset активной стороны модуля) между сторонами дублированного модуля 

произведите из узла управления MN, в окне Management Login �> System Management 
выберите соответствующий модуль в режиме Read/Write и выберите команду Administration -> 
Node Restart, на вопрос ответьте нажатием на кнопку Yes. 

• Сброс (reset) соответствующей стороны дублированного модуля произведите из узла 
управления MN, в окне Management Login �> System Management выберите соответствующий 
модуль в режиме Read/Write и выберите команду Administration -> Install Backup. В окне Install-
Backup выберите сторону дублированного модуля, для которой необходимо произвести 
сброс. Сброс выбранной стороны дублированного модуля осуществите с помощью меню 
Actions ->Restart. На вопрос ответьте нажатием кнопки Yes. 
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• На системной консоли платы CDB master дайте команды: 

pSH+> sync 
pSH+> reset  

Произошел Reset той стороны дублированного модуля, для которой была дана команда. 
  

• Выключение модуля произведите в соответствии с инструкцией по выключению дублированного 
модуля. Далее следует повторное включение с помощью выключателя на съемной плате PLC.  

3.2.2. Выключение дублированного модуля MLC 

Дублированный модуль обычно имеет в секции две съемных платы PLC, поэтому для выключения 
модуля целиком необходимо выключить обе эти платы. Отдельная плата PLC выключается 
выключателем вкл./выкл на самой плате PLC.Перед окончательным выключением питания файловая 
система закроется автоматически. 

3.3. Сброс (Reset) и выключение модуля 1U 

3.3.1. Сброс (повторная загрузка) модуля 1U 

Выполняется одно из следующих действий: 
• В MN, в окне Management Login � System Management выберите соответствующий модуль в 

режиме Read/Write и выберите команду Administration -> Node Restart, на вопрос ответьте, 
нажав кнопку Yes. 

• На системной консоли master платы CDB  дайте команды: 
pSH+> sync 
pSH+> reset  

• Нажмите кнопку reset (RST). 
• Выключение модуля произведите в соответствии с инструкцией по выключению модуля 1U с 

помощью выключателя на лицевой панели модуля 1U и снова включите через несколько 
секунд. 

3.3.2. Выключение модуля 1U 

Модуль 1U выключите с помощью выключателя On/Off на лицевой панели модуля. Система перед 
окончательным выключением питания произведет автоматическое закрытие файловой системы. 
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4. Процедуры замены на модуле MLC съемной 
платы CLC и находящихся на ней дочерних плат 

Перед каждым локальным вмешательством в аппаратные средства или программное обеспечение 
модуля MLC необходимо произвести перенос тарифных записей из модуля MLC в базу данных MN.  
  
Прежде всего перенесите записи СDR (Call Detailed Records) � подробные записи о вызовах из 
модуля MLC по запросу. Этим будет обеспечено перенесение подробных записей о вызовах на MN. 
 
Тарифные счетчики перенесите из модуля MLC по запросу в том случае, если они генерируются  и 
хранятся на самом модуле MLC. После переноса тарифных счетчиков из модуля MLC в базу данных 
MN сохраните состояние тарифных счетчиков в файл. 

4.1. Процедура замены съемной платы CLC в недублированном 
модуле MLC 

Как правило, необходимо заменить только дефектную компоненту съемной платы CLC, а не целиком 
съемную плату CLC со всеми ее компонентами вместе. Запрещается одновременно заменять 
материнскую плату CLC и диск в случае регистрирования и хранения тарифных счетчиков в BRAM на 
материнской плате CLC. В этом случае может произойти потеря тарифных записей (счетчиков) в 
BRAM материнской платы CLC. 
 
Съемную плату CLC нельзя извлекать из недублированного модуля MLC без 
предварительного выключения питания этого модуля. Недублированный модуль MLC 
выключается в соответствии с инструкциями по выключению питания недублированного 
модуля.  
 
После извлечения съемной платы CLC замените соответствующую часть ее аппаратных средств 
(TPE, диск, CDB, материнскую плату CLC, модем) в соответсвии с ошибкой, из-за которой 
производятся действия.  
 
Съемную плату CLC после замены неисправного элемента установите в секцию модуля и 
включите питание выключателем вкл./выкл. на съеной плате PLC. 

4.1.1. Замена диска  

Если известно, что диск является дефектным и его необходимо заменить, то замените только диск. В 
этом случае необходимо после включения модуля инициализировать новый диск (пункт 5.2) и 
повторно инсталлировать базу данных и программное обеспечение (глава 6). 
 
Если известно, что диск не поврежден, а неисправна плата CLC, необходимо переставить его с 
неисправной материнской платы CLC на новую материнскую плату CLC. Этим достигается 
сохранение базы данных, программного обеспечения, специфического программного обеспечения и 
тарифных данных на диске. 
 
Если известно, что диск не поврежден, а неисправна какая-либо из дочерних плат, то диск 
оставляется на съемной плате CLC. 
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4.1.2. Замена TPE, CDB, модема дочерней платы 

Если известно, что неиправна какая-либо дочерняя плата, возьмите новую дочернюю плату из 
комплекта ЗИП, которая должна быть такого же типа (соответствующее производственное состояние) 
как и поврежденная дочерняя плата. 
 
Новую дочернюю плату вставьте вместо неисправной дочерней платы. 
 
В базе данных после загрузки системы необходимо проверить и, при необходимости, изменить 
производственное состояние новой дочерней платы. 
 
В случае замены дочерней платы CDB проверьте соответствие версии ее флэш-памяти с помощью 
команды version на консоли в режиме работы pSH+> interpreter (Installation State) или в окне SYS -> 
Administration -> Check State, если модуль находится в состоянии In Operation 

4.1.3. Замена материнской платы CLC  

Возьмите новую съемную плату CLC из комплекта ЗИП. Если необходимо поменять материнскую 
плату CLC, то из неисправной платы CLC необходимо физически переставить диск на резервную 
материнскую плату. Остальные дочерние платы также  из неисправной материнской платы 
переставьте на новую. 
 
Прежде чем установить съемную плату CLC на монтажной позиции модуля, проверьте положение 
перемычки M6, предназначенной для включения аккумуляторной батареи (это самая ближняя 
перемычка к разъему для задней панели � находится рядом с аккумуляторной батареей). 
Аккумуляторная батарея во время работы съемной платы CLC должна быть включена (перемычка M6 
в положении 1-2):  
 

• положение 1 - 2 (аккумуляторная батарея включена, режим нормальной работы),  
• положение 2 - 3 (аккумуляторная батарея выключена, режим хранения).  

 
 

  
 
 
 
 
 
 
Положение 2-3   Положение 1-2  
- аккумуляторная батарея выключена  - аккумуляторная батарея включена 
 

Перемычка M6 
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После включения модуля подождите появления первой записи на консоли и нажмите любую кнопку 
(не более трех секунд). После чего будет выведено меню, в котором выберите пятую опцию для 
изменения IP-адресов платы CDB. Вводить IP-адреса на нижнюю (slave) дочернюю плату CDB не 
нужно, т.к. они будут записаны автоматически из установленных IP-адресов верхней (master) платы 
CDB. 
 
To change STARTUP MODE or system settings, press any key within 3 seconds 
 
  1 - Run-time installation 
  2 - Development installations 
  3 - System console 
  4 - Disk configuration 
  5 - Network configuration 
  6 - Other configuration 
  7 - Read configuration from file 
  8 - Advanced configuration 
 
 Please, select the option you want: [1] 5 
 
В меню выберите 5 - Network configuration. Адреса перепишите из Рабочего проекта. Если адреса, 
указанные в квадратных скобках, устраивают, то только подтвердите их нажатием кнопки enter, в 
противном случае введите необходимые. 
 
Do you want a LAN network interface? [Y] y <подтвердите нажатием Y> 
This board's IP address? [193.2.48.224] 193.2.48.224 <введите IP-адрес съемной платы CLC> 
Do you want a subnet mask for LAN interface? [N] y 
Subnet mask for LAN (0.0.0.0 for none)? [0.0.0.0] 255.255.255.0 <введите IP-адрес маски> 
Duplicated board's IP address? [0.0.0.0] <в случае недублированного модуля введите 0.0.0.0> 
Default gateway's IP address? [193.2.48.254] 0.0.0.0  <введите IP-адрес шлюза (gateway) > 
     < если шлюз (gateway) не определен - введите 0.0.0.0> 
Do you want a NISM interface? [N] y <подтвердите нажатием Y> 
NISM IP address [0.0.0.0 = automatic]? [193.2.48.16] <введите 0.0.0.0, NISM генерируется  
автоматически>  
Do you want a NISM subnet mask? [N] y <подтвердите нажатием Y> 
Subnet mask for shared memory (0.0.0.0 for none)? 255.255.255.0 <введите NISM IP-адрес маски> 
 
 
!!! The following IPs must have the same netid: 
!!! this board's IP, duplicated board's IP, default gateway's IP 
 
THERE WERE SOME ERRORS. Do you want to correct them? [Y]n <ответьте нажатием N> 
 
После введения IP-адресов повторно откроется начальное меню, в котором выберите 1 � Run-Time 
installation. Модуль загрузится и будет находится в режиме нормальной работы (In Operation). 
 
В базе данных проверьте и при необходимости измените производственное состояние (PS) новой 
материнской платы CLC. 
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4.2. Процедура замены съемной платы CLC в дублированном 
модуле MLC 

В дублированной системе присутствуют две съемных платы CLC. Во время проведения технических 
работ на неисправной съемной плате CLC вторая съемная плата CLC работает, т.е. в это время 
обеспечивает нормальное функционирование системы: сохраняет тарифные данные, выполняет 
диагностику системы... Необходимо убедиться в том, что интерфейсы Е1 съемной платы CLC, на 
которой в данный момент производится техническое вмешательство, не работают. Производить 
работы на съемной плате CLC можно также при полностью выключенном питании всего модуля MLC.  

4.2.1. Действия, выполняемые перед извлечением съемной платы CLC из 
дублированного модуля MLC 

Перед выполнением работ по замене неисправной съемной платы CLC убедитесь в том, что 
соседняя съемная плата CLC (работающая) находится в состоянии работы (In Operation). В окне 
Board Component (CMG -> Global -> HW Configuration -> Board -> Board Component) выберите 
неисправную съемную плату CLC, на которой будут выполняться работы и переведите ее в состояние 
разоборудованности (Equipement = Unequipped). 
 
Только после перевода параметра оборудованности неисправной платы CLC в положение 
Unequipped ее можно извлечь. Съемную плату CLC дублированного модуля можно извлекать и снова 
устанавливать без выключения питания модуля MLC. После извлечения съемной платы CLC 
замените соответствующую компоненту аппаратных средств данной платы (TPE, диск, CDB, 
материнскую плату CLC, модем) в соответствии с ошибкой, из-за которой производится техническое 
вмешательство.  

4.2.2. Процедуры замены неиспраного элемента съемной платы CLC в 
дублированном модуле MLC 

Съемную плату CLC установите в секцию модуля MLC. В окне Board Component (CMG -> Globa -> HW 
Configuration -> Board -> Board Component) выберите съемную плату CLC, на которой были 
проведены работы и переведите ее в состояние оборудованности (Equipement = Equipped).  

4.2.3. Замена диска 

Если известно, что диск поврежден и его необходимо заменить, то замените только диск. В этом 
случае,после установки съемной платы CLC в модуль, проведенной в соответствии с предписанной 
процедурой, новый диск необходимо инициализировать (пункт 5.2) и повторно инсталлировать на нем 
базу данных (глава 12 и пункт 6.2).  
Если известно, что диск исправен, неисправна только материнская плата CLC, переставьте его с 
неисправной материнской платы CLC на новую материнскую плату CLC. Благодаря этому на диске 
будут сохранены база данных, программное обеспечение, специальное программное обеспечение и 
тарифные данные.  
 
Если известно, что диск не поврежден, а неисправна какая-либо из дочерних плат, то диск на 
съемной плате CLC оставляется. 
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4.2.4. Замена дочерних плат TPE, CDB 

Из комплекта ЗИП возьмите новую дочернюю плату. Она должна быть такого же типа 
(соответствующее производственное состояние), как и поврежденная дочерняя плата.  
 
Новую съемную плату установите на место неисправной. 
 
В базе данных после загрузки системы необходимо проверить и при необходимости соответственно 
изменить производственное состояние (PS) новой дочерней платы. 
 
Проверьте соответствие версии флэш-памяти новой дочерней платы CDB с помощью команды 
version на консоли в режиме работы pSH+> interpreter (Installation State) или в окне SYS -> 
Administration -> Check State, если модуль находится в состоянии Cold Stand By. 

4.2.5. Замена материнской платы CLC  

Из комплекта ЗИП возьмите новую материнскую плату CLC. В том случае, если необходимо заменить 
только материнскую плату CLC, диск физически переставьте из неисправной материнской платы CLC 
на новую материнскую плату. Дочерние платы переставьте из неисправной материнской платы CLC 
на новую материнскую плату CLC. 
 
Прежде чем установить съемную плату CLC в секцию модуля проверьте положение перемычки M6, 
предназначенной для включения аккумуляторной батареи. Это самая ближняя перемычка к разъему 
для задней панели � находится рядом с аккумуляторной батареей. Аккумуляторная батарея во время 
работы съемной платы CLC должна быть включена (перемычка M6 в положении 1-2):  
 

• положение 1 - 2 (аккумуляторная батарея включена, режим нормальной работы),  
• положение 2 - 3 (аккумуляторная батарея выключена, режим хранения). 

 
 

  
 
 
 
 
 

 
 Положение 2-3   Положение 
 - аккумуляторная батарея выключена - аккумулято
 

Перемычка M6
 15 

1-2  
рная батарея включена 
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После установки съемной платы CLC в соответствии с предписанными правилами подождите 
появления начальной записи на консоли и нажмите любую кнопку не более чем на три секунды. Будет 
выведено меню, в котором выберите пятую опцию для изменения IP-адресов платы CDB. IP-адреса 
на нижнюю (slave)дочернюю плату CDB  вводить не нужно, т.к. они вводятся автоматически из 
установок IP-адресов верхней (master) платы CDB. 
 
To change STARTUP MODE or system settings, press any key within 3 seconds 
 
  1 - Run-time installation 
  2 - Development installations 
  3 - System console 
  4 - Disk configuration 
  5 - Network configuration 
  6 - Other configuration 
  7 - Read configuration from file 
  8 - Advanced configuration 
 
 Please, select the option you want: [1] 5 
 
В меню выберите 5 - Network configuration. IP-адреса перепишите из Рабочего проекта. Если адреса, 
написанные в квадратных скобках, соответствуют, то только подтвердите их нажатием кнопки enter, в 
противном случае введите необходимые. 
 
Do you want a LAN network interface? [Y] <подтвердите нажатием Y> 
This board's IP address? [193.2.48.224] 193.2.48.224 <введите IP-адрес съемной платы CLC> 
Subnet mask for LAN (0.0.0.0 for none)? [255.255.255.0] 255.255.255.0 <введите IP-адрес маски> 
Duplicated board's IP address? [0.0.0.0] 193.2.48.225 <введите IP-адрес дублированного модуля 
съемной платы CLC> 
Default gateway's IP address? [0.0.0.0] 0.0.0.0 <введите IP-адрес шлюза (gateway) > 

     < если шлюз (gateway) не определен - введите 0.0.0.0> 
Do you want a NISM interface? [Y] y <подтвердите нажатием Y> 
NISM IP address [0.0.0.0 = automatic]? [193.2.48.16] <введите 0.0.0.0, NISM генерируется 
автоматически> 
Subnet mask for shared memory (0.0.0.0 for none)? [255.255.255.0] <введите NISM IP-адрес маски> 
 
 
!!! The following IPs must have the same netid: 
!!! this board's IP, duplicated board's IP, default gateway's IP 
 
THERE WERE SOME ERRORS. Do you want to correct them? [Y]n <ответьте нажатием N> 
 
 
После ввода IP-адресов снова появится начальное меню, в котором нужно выбрать 1 � Run-Time 
installation. Модуль загрузится и будет находиться в режиме нормальной работы. 
 
В базе данных проверьте и при необходимости измените производственное состояние (PS) новой 
съемной платы. 
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5. Процедуры замены модуля 1U  

Перед каждым вмешательством в аппаратные средства и программное обеспечение модуля 1U 
необходимо выполнить перенос тарифных записей из модуля в базу данных MN.  
 
Прежде всего перенесите записи СDR (Call Detailed Records) � подробные записи о вызовах из 
модуля 1U по запросу. Этим будет обеспечено перенесение подробных записей о вызовах на MN.   
 
Тарифные счетчики перенесите из модуля 1U по запросу в том случае, если они генерируются  и 
хранятся на самом модуле 1U. После переноса тарифных счетчиков из модуля MLC в базу данных 
MN, сохраните состояние тарифных счетчиков в файл.   
 
При неисправности модуля 1U, как правило, идет его полная замена. При этом необходимо обратить 
внимание на то, что бы резервный модуль 1U обладал той же конфигурацией аппаратных средств, 
что и неисправный: TPE, CDB, материнская плата CLC, диск.  

5.1. Замена модуля 1U и установка перемычки, определяющей 
работу аккумуляторной батареи 

Возьмите новый модуль 1U из комплекта ЗИП. Он должен иметь такую же конфигурацию аппаратных 
средств, как и заменяемый модуль (дочерние платы TPE, CLC, CDB, диск). 
 
Перед заменой модуля 1U проверьте положение перемычки  M12, служащей для включения  
аккумуляторной батареи. На материнской плате CLC на переднем крае платы находится перемычка 
M12 для включения аккумуляторной батареи (см.рис.). Перемычка установлена производителем в 
положение 1-2, в процессе работы модуля перемычка M12 должна находиться в положении 2-3. Для        
доступа к перемычке отвинтите лицевую панель корпуса модуля и  вместе с платой CLC отодвиньте 
примерно на 3 см.  
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Выключите питание неисправного модуля 1U в соотвествии с установленными правилами по 
выключению питания модуля 1U. Отключите все кабели с лицевой панели. Модуль 1U замените на 
новый. Включите  питание выключателем On/Off, находящемся на лицевой панели модуля. 
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5.2. Инициализация диска  

 
Минимальная емкость диска для модуля SAN - 80MB. Рекомендуемое число 
файлов на диске при его инициализации - 10000, минимальное -  2000. 

 
После включения или перезагрузки (reset) модуля обождите появления начальной записи на консоли 
и в течение 3 секунд нажмите любую кнопку.  
 
To change STARTUP MODE or system settings, press any key within 3 seconds 
 

1 - Run-time installation 
2 - Development installations 
3 - System console 
4 - Disk configuration 
5 - Network configuration 
6 - Other configuration 
7 - Read configuration from file 
8 - Advanced configuration 

 
Please, select the option you want:  [1] 4 
 
Отбразится подменю, в котором нужно выбрать 4 - Initialize disk и подтвердить нажатием y. 
 

1 - Boot dir 
2 - Disk verification mode 
3 - Format & initialize disk 
4 - Initialize disk 
5 - Select BOOT media 

 
X - Return to the main menu 

 
Please, select the option you want:  [�] 4     (выберите 4) 
Do you really want to initialize disk? [N] y     (подтвердите Y) 
Updating parameter storage. This may take a while...Done 
 
Last loading ...... Ok 
System time ....... 9:43:27 16/09/2003 
Disk .............. Transaction control records at 0x00010000 (DRAM) 
                ... No transaction control records found. 
                ... DISK 0 M-SYSTEMS IDEL                           22526003 
         Ver.6.6  Size 156 
Full disk capacity is 156 Mb (319998 blocks). 
Do you want to reduce volume size? [N] n     (ответьте N) 
Enter max number of files on the file system:  [10000] 10000   (введите 10000) 
Max number of files is 10000. 
 
I'M INITIALIZING DISK DEVICE NOW ... Done 
 
Writting system parameters to file ... Done 
 
Copyright (c) Integrated Systems, Inc., 1992. 
Welcome to pSOSystem... 
 
pSH+> 
 
По окончанию инициализации диска модуль загрузится в режиме работы pSH+> interpreter (Installation 
State).  
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5.3. Ввод IP-адресов 

Произведите сброс (Reset) модуля, подождите появления начальной записи на консоли и в течение 3 
секунд нажмите любую кнопку. Появится меню, в котором выберите опцию 5 для изменения IP-
адресов платы CDB. IP-адреса на нижнюю (slave) дочернюю плату CDB вводить не нужно, т.к. они 
вводятся автоматически из установленных IP-адресов верхней (master) платы CDB 
 
To change STARTUP MODE or system settings, press any key within 3 seconds 
 
               1 - Run-time installation 
               2 - Development installations 
                3 - System console 
                4 - Disk configuration 
                5 - Network configuration 
                6 - Other configuration 
                7 - Read configuration from file 
                8 - Advanced configuration 
 
 Please, select the option you want:  [1] 5 
 
Выберите в меню 5 - Network configuration. Адреса перепишите из Рабочего проекта. Если адреса, 
написанные в квадратных скобках, соответствуют, то только подтвердите их нажатием кнопки enter, в 
противном случае введите необходимые. 
 
Do you want a LAN network interface? [Y] <подтвердите нажатием Y> 
This board's IP address? [193.2.48.224] 193.2.48.224 <введите IP-адрес съемной платы CLC> 
Do you want a subnet mask for LAN interface?  [N] y 
Subnet mask for LAN (0.0.0.0 for none)? [0.0.0.0] 255.255.255.0 <введите IP-адрес маски> 
Duplicated board's IP address? [0.0.0.0] <в случае недублированного модуля введите 0.0.0.0> 
Default gateway's IP address? [193.2.48.254] 0.0.0.0 <введите IP-адрес шлюза (gateway) > 

     < если шлюз (gateway) не определен - введите 0.0.0.0> 
Do you want a NISM interface? [Y] y <подтвердите нажатием Y> 
NISM IP address [0.0.0.0 = automatic]? [193.2.48.16] <введите 0.0.0.0, NISM генерируется 
автоматически> 
Subnet mask for shared memory (0.0.0.0 for none)?[255.255.255.0 <введите NISM IP-адрес маски> 
 
 
!!! The following IPs must have the same netid: 
!!! this board's IP, duplicated board's IP, default gateway's IP 
 
THERE WERE SOME ERRORS. Do you want to correct them? [Y]n <ответьте нажатием N> 
 
 
После ввода IP-адресов снова появится начальное меню, в котором нужно выбрать 3 � System 
console. Модуль загрузится и будет находиться в режиме работы pSH+> interpreter (Installation State). 

5.4. Проверка версий флэш-памяти плат CDB 

Проверьте соответствие версии флэш-памяти дочерних плат CDB, являющихся составной частью 
модуля 1U. Это проверяется командой version на консоли в режиме работы pSH+> interpreter 
(installation State) или из окна SYS -> Administration -> Check State, если модуль находится в состоянии 
In Operation. 
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5.5. Процедура инсталляции программного обеспечения, базы 
данных и специального програмного обеспечения на диск 
модуля 1U  

После успешной инициализации диска и ввода IP-адресов на модуль 1U необходимо инсталлировать 
программное обеспечение, базу данных и специальное программное обеспечение. Процедура 
описана в главе 6. 
 
В базе данных после инсталляции системы  нужно проверить и при необходимости соответственно 
ищменить производственное состояние дочерних плат (материнская плата CLC, CDB, TPE...), 
являющихся элементами модуля 1U. 
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6. Процедура инсталляции программного пакета и 
базы данных на диск модуля MLC и модуля 1U 

В случае замены диска на модуле MLC или замены модуля 1U необходимо произвести процедуру 
инсталляции программного обеспечения, специфичного программного обеспечения и базы данных. 
Такую инсталляцию необходимо произвести в исключительных ситуациях потери (повреждения) 
файловой системы, находящейся на диске. 
 
Когда диск физически находится на удаленном модуле MLC или на 1U, инсталляцию произведите из 
MT, который необходимо транспортировать на место, где расположен модуль MLC. Предварительно 
нужно согласовать базу данных MT с базой данных MN для данного модуля. 
 
Если модуль MLC или 1U находится на одной локации с компьютером MN, то процедура инсталляции 
программного обеспечения, специфического программного обеспечения  и базы данных на модуль 
производится из MN. В данном случае процедуры согласования баз данных между MN и MT, 
описанные в пункте 6.1, опускаются. 
 
Внимание: в этой главе описана работа терминала управления MT с использованием 
«классических» команд (Export, Import,...), в пункте 8 - описание работы MT с использованием 
команд из группы MT intervention. Пользователь должен выбрать ту процедуру, которая ему в 
данной ситуации кажется наиболее подходящей.  
 
В систему дублированного LS5073 введен дополнительный механизм по 
согласованию/инсталляции базы данных модуля MLC на стороне Cold Stand By без 
прерывания работы стороны In Operation модуля MLC. Процедура описана в главах 10 и 11. По 
окончанию работ, благодаря этим процедурам обеспечивается правильный перенос базы 
данных, генерируемой на In Operation-стороне модуля в процессе проводимых работ, на Cold 
Stand By-сторону модуля и MN.  
 
Процедура инсталляции программного пакета и данных на модуль MLC разделена на две части: 
 
• Согласование баз данных на MT (notebook) и MN, происходящее на месте непосредственного 

расположения MN; 
• Инсталляция диска на модуле MLC из MT, происходящее на месте непосредственного 

расположения модуля MLC.  

6.1. Согласование баз данных на MT (notebook) и MN на месте 
непосредственного расположения MN 

Войдите в систему МТ как пользователь mnadmin. Перед подключением MT к базе данных MN 
необходимо установить IP-адрес для терминала MT на значение, которое определено в Рабочем 
проекте для непосредственного подключения MT и MN. IP-адрес терминала MT измените в меню Start 
-> Settings -> Control Panel. Откроется окно Control Panel, в котором выберите значок Network. 
Откроется окно Network, в котором выберите вкладку Protocols. 
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В окне Network-Protocols отметьте TCP/IP Protocol и нажмимте кнопку Properties� появится 
следующее окно: 

 
 
В поле IP Address введите IP-адрес терминала MT, а в поле Subnet Mask � значение для subnet mask, 
определенное Рабочим проектом для такого подключения. Ввод подтвердите нажатием кнопки OK и 
закройте все окна. После изменения IP-адреса MT необходимо выполнить перезапуск (restart) MT. 
 
Войдите в систему как пользователь sysadmin.  
 
Выберите в меню Start -> Programs -> Management Node -> MN Configuration. Откроется следующее 
окно: 
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Во вкладке MN server hostname выберите имя центрального MN, этим определяется текущая связь 
графических окон NewEra с базой данных на MN. Данный параметр подтвердите нажатием кнопки 
OK. Выберите Start -> Programs -> Management Node -> MN Login и запустите приложение SYS. В окне 
отобразятся все модули, записанные в базе данных MN. В основном окне в режиме Read/Write 
отметьте (выберите) модуль, для которого нужно согласовать данные, а также выберите 
Administration -> Database -> Node Data -> Export, благодаря чему будет выполнен экспорт и 
сохранение данных о данном модуле на жестком диске MT. 
 
По окончанию процедуры сохранения данных закройте окна SYS и MNlogin и выйдите из системы. 
Повторный вход в систему осуществите в качестве пользователя sysadmin. 
  
На MT выберите в меню Start -> Programs -> Management Node -> MN Configuration. Откроется окно 
MN Configuration Settings, где во вкладке MN server hostname выберите соответствующий MT, 
благодаря чему снова устанавливается связь с базой данных на MT. Выберите Start -> Programs -> 
Management Node -> MN Login и запустите приложение SYS. В окне отобразятся все модули, 
записанные в базе данных MT. Проверьте, присутствует ли уже в базе данных MT модуль, для 
которого нужно согласовать данные. Если нет � его необходимо создать. Если уже существует, то 
продолжайте в следующем порядке. 
 
Запустите приложение SYS и выберите необходимый модуль в режиме Read/Write. Текущее 
согласование данных нужно заблокировать путем установки в окне Administration -> DB Syncronisation 
параметра в состояние Off. Теперь необходимо в локальную базу MT перенести (импортировать) 
данные, сохраненные в базе данных MN. Это выполняется с помощью меню Administration -> 
Database -> Node Data -> Import. 
 
Теперь в базе MT данные для выбранного модуля согласованы с базой данных MN. Перед 
физическим подключением MT к определенному модулю MLC через ethernet необходимо установить 
IP-адрес для терминала MT в соответствии с Рабочим проектом. Этот адрес определен в проекте 
вместе с другими адресами определенного модуля и обозначен MT. Теперь MT готов для работы на 
месте непосредственного расположения модуля MLC. 
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6.2. Инсталляция программного обеспечения, данных и 
специфического программного обеспечения на диск модуля 
MLC и 1U 

Диск можно инсталлировать только в том случае, если модуль установлен в состояние инсталляции 
(Installation State). Состояние инсталляции можно установить двумя способами: 

• После включения/сброса модуля обождите появления начальной записи на консоли и 
нажмите любую клавишу (в течении трех секунд). Появится меню, в котором выберите опцию 
для определения конфигурации диска (3 � System Console), 

• Модуль, находящийся в работе (In Operation / Cold Stand By) установите в состояние 
инсталляции через меню SYS->Administration->Inslall Backup-> Install Backup. 

 
Войдите в систему в качестве пользователя sysadmin. Прежде всего необходимо экспортировать 
данные из базы данных. На MN/MT выберите приложение MNlogin, далее выберите соответствующий 
модуль и откройте приложение System Management (SYS). Выберите необходимый модуль Select 
Node, в окне - опцию Read/Write и в поле Status напротив необходимого модуля выберите Selected, 
закройте с помощью Close. Выберите в меню: Administration -> Database -> Node Data -> Export. 
Откроется следующее окно: 
 

 
 

Убедитесь, что номер модуля (Node) соответствует номеру необходимого модуля, введите имя 
директория, в котором необходимо сохранить данные и нажмите �Run�. Теперь откроется окно, в 
котором подтвердите ввод нажатием �Yes�. Начнет выполняться процедура экспорта данных из базы 
данных. 
 
На модуль необходимо перенести также специальные данные (Specific Software), т.е. файлы mn_data, 
agent.cnf, csup_enable (присутствие файла csup_enable на директории etc � условие для 
активирования дублированной работы модуля) и init_net. Они находятся на директории 
si2000/install/Sn/«Snexchid«/A_side/etc (exchid � номер вашего модуля). Эти файлы можете перенести 
(вместе с остальными данными) с помощью процедуры, описанной в следующем пункте (Install SW 
and Data) или отдельно в соответствии с процедурой (Install Specific SW). Если эти данные на 
соответствующем директории уже существуют, перейдите к следующему пункту. Если же нет � 
введите их. Для создания файла mn_data откройте окно выбором Administration -> IP Network -> MN 
Hostname и введите имя и IP-адрес компьютера МN. Для создания файла agent.cnf откройте окно 
выбором Administration -> IP Network -> SNMP Agent и введите IP-адрес компьютера МN в поле MN 
Trap Destinations. Файл init_net создайте в окне Administration -> IP Network -> IP Routing. 
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После окончания экспортирования данных и после проверки или подготовки специальных данных, 
снова выберите требуемый модуль в приложении System Management (SYS) в режиме Read/Write. 
Выберите меню Administration -> Install - Backup. Откроется окно Install � Backup, изображенное на 
нижнем рисунке. Снова проверьте, записан ли номер требуемого модуля в параметре Exchange. В 
окне Install - Backup выберите меню Actions -> File Transfer -> Install для полной активизации окна. 
Параметр Generic Version установите в соответствии с действующей версией программного пакета. 
Для параметра Mode установите опцию SW and Data, для параметра Data Version выберите 
директорий, на котором предварительно были сохранены данные, а для параметра Username � 
введите имя пользователя (если ситема защиты не активирована, введите любые знаки), Password - 
введите пароль модуля (предустановленный пароль - psos).  
 

 
 

Нажмите кнопку �Run�, начнет выполняться процедура инсталляции модуля. Откроется окно, в 
котором необходимо еще раз подтвердить инсталляцию модуля, нажав кнопку �Yes�. Сообщение об 
окончании процедуры выводится на экран MT в виде файла, содержащего всю историю инсталляции. 
 
Файловая система модуля позволяет работать с большим количеством директориев, поэтому 
необходимо определить директорий, активный в данный момент. Параметр Generic Version измените 
на Boot File и повторно нажмите кнопку �Run�.  
 
По окончанию инсталляции модуля выберите меню Actions -> Restart в окне Install - Backup. Модуль 
загрузится и будет находится в режиме нормальной работы. 
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7. Процедура замены съемной платы PLC - модуль 
MLC 

Съемную плату PLC выключите с помощью выключателя на плате PLC. Процедура выключения 
съемной платы PLC в модуле MLC описана в пункте 3.1.2. и 3.2.2. Если модуль MLC 
недублированный, то выключение питание всего модуля производится с помощью выключателя на 
съемной плате PLC. Съемная плата PLC в дублированном модуле заменяется без отключения 
питания всего модуля (вторая съемная плата PLC в это время обеспечивает нормальную работу 
модуля). Таким образом, выключите неисправную съемную плату PLC с помощью выключателя на 
съемной плате. 
 
Отключите кабель электропитания и извлеките неисправную съемную плату PLC, перед этим 
необходимо убедиться, что съемная плата PLC выключена. При замене съемной платы PLC на 
новую, при необходимости переставьте плату KLB с поврежденной платы на новую или, если же на 
новой плате PLC она уже есть, ставьте новую без изменений. 
 
Вставьте новую съемную плату PLC в модуль, подключите кабель электропитания и включите 
съемную плату с помощью выключателя. Модуль загрузится и будет находится в режиме нормальной 
работы. 
 
В базе данных проверьте и, по необходимости, установите соответствующее производственное 
состояние (PS) новой съемной платы. 
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8. Работа на терминале управления MT при помощи 
группы команд MT intervention 

В этом разделе дается описание работы на терминале управления MT при инсталляции 
программного пакета и полупостоянных данных (SPD) на диск модуля MLC, а также при 
вмешательстве в случае пропадания коммуникации между узлом управления MN и модулем. 
Процедура идентична процедуре, описанной в пункте 6, с разницей в используемых командах, в 
данном случае используются команды группы MT Intervention. 
 
Различие между процедурами, описанными в пункте 6 и данной процедурой в том, что с ее помощью 
упрощается экспорт полупостоянных данных из центральной базы данных в MN, а также упрощается 
импорт данных в локальную базу MT через директорий, установленный по умолчанию. Также 
появляется дополнительная возможность регистрирования изменений данных (DB Logging), при 
которой все изменения на модуле записываются в файл на диске MT, откуда с помощью 
определенной команды их переносятся в центральную базу данных на MN. 
 
Группа команд предназначена для: 
 
• блокировки управления модулем из MN и для подготовки MT к проведению оперативных действий 

непосредственно на объекте с помощью команды MT Data preparation; 
• начала оперативных действий в модуле из MT с помощью команды Start MT intervention; 
• окончания оперативных действий в модуле из MT с помощью команд Terminate MT intervention; 
• передачи измененных данных из базы данных модуля в центральную базу данных и 

разблокировки управления модулем из MN с помощью команды Reactivate MN. 

8.1. Подготовка терминала управления MT � согласование баз 
данных между MT (Notebook) и MN на месте непосредственного 
расположения MN 

Войдите в систему как пользователь mnadmin. Перед подключением MT к базе данных MN 
необходимо установить IP-адрес MT на значение, определенное а Рабочем проекте для 
непосредственного подключения MT и MN. IP-адрес MT измените в меню Start -> Settings -> Control 
Panel. Откроется окно Control Panel, в котором выберите значок Network. Откроется окно Network, в 
котором выберите вкладку Protocols. В окне обозначьте TCP/IP Protocol и нажмите кнопку Properties� 
появится следующее окно: 
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В поле IP Address введите IP-адрес MT, в поле Subnet Mask � значение маски subnet mask, проектно 
определенной для такого подключения. Ввод подтвердите нажатием кнопки OK и закройте все окна. 
После изменения IP-адреса необходимо произвести перезапуск (restart) MT, для чего в меню 
выберите Start -> ShutDown� 
 
Войдите в систему в качестве пользователя sysadmin. Выберите в меню Start -> Programs -> 
Management Node -> MN Configuration. Откроется следующее окно, в котором в поле MN server 
hostname выберите имя центрального MN, чем определяется данное соединение графических окон 
NewEra с базой данных на MN. Установку параметров подтвердите нажатием кнопки OK. 
 

 
 

Выберите Start -> Programs -> Management Node -> MN Login и запустите приложение SYS. В окне 
отобразятся все модули, записанные в базе данных MN. В основном окне отметьте (выберите) 
соответствующий модуль в режиме Read/Write и подготовьте данные, необходимые для проведения 
оперативных действий из MT, с помощью команды Administration -> MT Intervention -> MT Data 
Preparation. Для ввода изменений, запустите модуль с помощью виртуального пользователя 
mtadmin, текущее согласование данных блокируется, и данные модуля на основании 
предварительного подтверждения, экспортируются в локальный архив default, где они хранятся до 
передачи в локальную базу данных в MT. 
По окончанию процедуры закройте окна SYS и MNlogin и выйдите из системы. Повторно войдите в 
систему, теперь в качестве пользователя sysadmin.  
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На MT выберите в меню Start -> Programs -> Management Node -> MN Configuration. Откроется окно 
MN Configuration Settings, в поле MN server hostname опять выберите свой MT, после чего 
осуществится связь с локальной базой данных в MT. Выберите Start -> Programs -> Management Node 
-> MN Login и запустите приложение SYS. В окне отобразятся все модули, записанные в базе данных 
MT. 
 
Выберите необходимый модуль в режиме Read/Write. Заблокируйте текущее согласование данных, 
для чего в окне Administration -> DB Syncronisation параметр установите в положение Off. Далее 
следует начало работ MT с помощью команды Administration -> MT Intervention -> Start MT Intervention, 
которая произведет импорт полупостоянных данных модуля из локального архива default в 
локальную базу данных на MT. Активизируется процедура регистрирования изменения данных 
модуля, при которой все изменения данных будут записаны в файл на диск терминала MT. Если этот 
файл уже существует, его можно удалить или вносить в него изменения. Активность регистрирования 
изменений данных отображается параметром DB Logging, имеющего значение On. 
 
Теперь база данных этого модуля в МТ согласована с базой данных в MN. Перед физическим 
подключением MT на определенный модуль через ethernet, необходимо установить IP-адрес MT в 
соответствии с Рабочим проектом. Этот адрес определен в проекте вместе с другими адресами 
определенного модуля и обозначен MT. Процедура установления IP-адресов описана в пункте 6.1. 
Теперь MT готов для работы на месте непосредственного расположения модуля MLC. 

8.2. Инсталляция диска из MT на месте непосредственного 
расположения модуля MLC, модуля 1U 

Процедура инсталляции диска на месте непосредственного расположения модуля идентична 
процедуре, описанной в пункте 6.2.  

8.3. Подготовка терминала управления MT для подключения к узлу 
управления MN и передача измененных данных модуля MLC, 
модуля 1U  на узел управления MN 

По завершению локального управления модулем необходимо подготовить измененные данные 
модуля для передачи в MN. Завершите вмешательство с терминала MT на соответствующий модуль 
в окне SYS с помощью команды Administration -> MT Intervention -> Terminate MT Intervention. 
 
Войдите в систему как пользователь mnadmin. Перед подключением MT к базе данных MN 
необходимо установить IP-адрес MT на значение, проектно определенное для непосредственного 
подключения MT и MN, как описано в пункте 6.1. Таким образом, выбором центральной базы данных 
определяется текущее соединение графических окон NewEra с базой данных на MN, как это описано 
в пункте 6.1. 
 
Выберите Start -> Programs -> Management Node -> MN Login и запустите приложение SYS. В окне 
отобразятся все модули, записанные в базе данных MN. В основном окне отметьте (выберите) 
соответствующий модуль в режиме Read/Write и, с помощью команды Administration -> MT Intervention 
-> Reactivate MN, перенесите изменения данных, выполненные в модуле, в центральную базу данных 
на MN, активизируйте текущее согласование данных, а также управление модулем из MN 
посредством удаления виртуального пользователя mtadmin, который блокировал занятие модуля 
для выполнения изменений. 



 
 

SOP6307M0-ATR-020 30

9. Инструкция по переносу базы данных из модуля 
MLC, 1U в базу данных MN 

Из-за наличия различных ошибок и неправильного проведения процедур во время 
администрирования может возникнуть несогласованность баз данных в MN и модуле MLC, 1U. Для 
обеспечения согласованности баз данных на модуле и MN необходимо ежемесячно делать 
резервную копию данных из модуля в MN. Необходимо также делать копию данных модуля перед 
каждой наиболее значительной процедурой администрирования, например, при добавлении новых 
плат или большого количества абонентов � 
 
Процедура включает в себя следующие действия: 
• Резервное копирование базы данных из модуля в файловую систему компьютера MN, 
• Экспорт базы данных модуля в файловую систему компьютера MN, 
• Импорт базы данных в базу данных MN.  
 
Войдите в систему как пользователь sysadmin.  

9.1. Резервное копирование базы данных из модуля MLC, 1U в 
файловую систему компьютера MN  

В окне System Management (SYS) в режиме Read/Write выберите необходимый модуль. Выберите в 
меню Administration -> Install - Backup. Откроется окно Install - Backup, отбраженное на следующем 
рисунке. Проверьте, что бы у параметра Exchange был записан номер требуемого модуля. В окне 
Install выберите в меню Actions -> File Transfer -> Backup, окно полностью активируется. Для 
параметра Mode установите опцию Data From File System. Для параметра Data Version введите имя 
деректория, в котором необходимо сохранить базу данных: например, backup181002. Имя директория  
говорит о том, в какой директорий файловой системы компьютера MN будет производиться 
копирование базы данных модуля.  В имени директория обычно отображается имя резервной копии и 
соответствующая дата. В качестве параметра Username � введите имя пользователя; в качестве 
Password � пароль модуля (пароль - psos). 
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Нажмите кнопку �Run�, начнет выполняться передача базы данных из модуля в файорвую систему 
компьютера MN. Откроется окно, в котором еще раз подтвердите необходимость передачи данных, 
нажав кнопку �Yes�. При окончании процедуры переноса данных из модуля придет сообщение: 
«Backup done».  

9.2. Копирование базы данных  MN модулей  MLC, 1U в файловую 
систему компьютера MN  

В профилактических целях необходимо произвести экспорт базы данных в файловую систему 
компьютера MN. Это означает, что база данных компьютера MN выбранного модуля скопируется в 
директорий файловой ситемы компьютера MN. В окне приложения System Management (SYS) 
выберите модуль в режиме Read/Write и меню Administration -> Database -> Node Data -> Export. 
Откроется следующее окно: 
 

 
 

Убедитесь, что выбран нужный модуль, и введите имя директория, в который будете экспортировать 
данные. Для старта процедуры экспорта базы данных для выбранного модуля нажмите �Run�. 
Откроется новое окно, в котором необходимо ответить �Yes�. Начнет выполняться процедура 
экспорта данных из базы данных, которая может продолжаться несколько минут. 
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10. Инструкция по созданию резервной копии 
specific SW модуля MLC, 1U  

Благодаря этой процедуре создается резервная копия специального программного обеспечения, 
находящегося на диске модуля (директорий etc). Данные нужны при повторной инсталляции 
специального программного обеспечения на диск модуля. 
 
В окне откройте меню Administration -> Install - Backup. В окне Install - Backup выберите Actions -> File 
Transfer -> Backup, в опции Mode выберите Specific SW и нажмите кнопку Run. 
 
В дублированном модуле MLC копии специального  программного обеспечения создайте отдельно 
для каждой стороны модуля. 
 

  
 
После этой процедуры специальное программное обеспечение для каждого модуля отдельно 
находится в директории si2000/install/Sn/«Snexchid«/A_side/etc (exchid � это номер модуля) или 
si2000/install/Sn/«Snexchid«/B_side/etc для стороны B  
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11. Процедура сравнения/согласования баз данных 
MN и модулнй MLC и 1U, находящихся в 
состоянии In Operation 

Процедура используется тогда, когда необходимо сравнить или согласовать базы данных узла MN и 
модуля, находящегося в состоянии работы (In Operation). Если будут выявлены различия между 
базой MN и базой In operation-стороны модуля, выполните согласование баз без остановки работы 
модуля по описанной далее процедуре. Если процедура согласования данных не окажется успешной, 
то для проведения дальнейших действий будет необходимо проконсультироваться с сервисной 
службой Iskratel. 

11.1. Сравнение баз данных узла MN и модуля 

Перед началом сравнения данных между MN и модулем, находящимся в состоянии In Operation, 
сделайте две резервных копии данных, одну из MN (SYS -> Administration -> Database -> Node Data -> 
Export) и вторую - из файловой системы модуля (SYS -> Administration -> Install-Backup -> Actions -> 
File Transfer -> Backup -> Mode=Data From File System).  
 
Сравнение данных между базами MN и модуля выполните с помощью приложения Data Supervision 
(SYS -> Administration -> Data Supervision). В окне SYS выберите модуль, для которого необходимо 
сравнить базу данных MN с данными резервной копии этого модуля. 
 

 
 

Откройте окно Data Supervision Center, в котором выберите эталонный MN, т.е. имя MN, на котором 
работаете. В окне Node выберите/проверьте Node-номер модуля, на котором необходимо произвести 
сравнение данных. 
 
Нажмите кнопку + в имени Informix-сервера (например, ol_sets4c) на правой половине окна появятся 
все базы, имеющиеся на сервере. Выберите комбинацию DBRELEASEDATARELEASE, относящуюся к 
модулю, для которого производите сравнение данных, в данном случае: LNBB0A09LNBS0A11. В 
правой половине окна появится перечень группы таблиц, входящих в состав базы данных. Отметьте 
группу таблиц Database в окне на правой половине окна. 
 
После этого из меню выберите команду Task �> Comparison Data Selection -> UNL Files. Откроется 
окно Select Folder with UNL Files, в котором выберите директорий резервной копии данных модуля 
(файлы unl). Лучше всего, чтобы полупостоянные данные модуля были самыми свежими. Выбор 
подтвердите нажатием OK. Теперь произойдет копирование таблиц unl, после которого 
предоставляется доступ к меню Data Supervision. 
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Из меню выберите команду Task �> Data Supervision, откроется окно Data Supervision. В нем 
проверьте и установите:  
 

• в строке Node - номер модуля, 
• проверьте цвет кнопки S � если он зеленый, это значит, что согласование данных для этого 

модуля установлено на On. 
 
Установки параметров в остальных полях должны быть аналогичны установкам, приведенным на 
следующем рисунке, следовательно должен быть выбран нужный модуль и в поле Reference 
Database Server соответствующий сервер DBRELEASEDATARELEASE@ol_имя_сервера, (например, 
LNBB0A09LNBS0A11@ol_sets4c). Во вкладке SQL находится поле, в котором выберите номер модуля 
(выберите Network, имя модуля, базу данных и номер модуля; в данном случае 2050).  

 

 
 
Сравнение базы данных MN (эталонный сервер) с базой данных модуля (с ее резервной копией) 
запустите с помощью меню SQL -> Prepare -> Reference To Comparison. Во вкладке SQL после 
сравнения таблиц будут выведены различия между базами данных MN (сервера) и модуля 
(резервной копии) в виде SQL-операторов.  

11.2. Согласование баз данных MN и модуля  

На основе информации SQL-операторов, генерируемых в процессе сравнения баз данных, 
необходимо определить, нужно ли проводить согласование данных и, если нужно, то в каком 
направлении это делать.  
 
Если на основании информации SQL-операторов будет определено, что правильной является база 
данных на стороне сервера MN, то соответственно, согласование данных произведите с помощью 
меню SQL ->Execute -> All. SQL-операторы, которые были сгенерированы в процессе сравнения баз 
данных, посылаются в модуль. Успешность передачи SQL-операторов в модуль проверьте в нижней 
части вкладки SQL (log-окно).  
 
Если на основании информации SQL-операторов определено, что правильной является база данных 
на самом модуле, произведите новое сравнение баз данных в обратном направлении (от модуля к 
серверу MN); с помощью меню SQL -> Prepare -> Comparison To Reference. Во вкладке SQL после 
проведения сравнения таблиц будут выведены различия баз данных модуля (их резервной копии) и 
сервера MN в виде SQL-операторов. Согласование базы данных (SQL-операторов во вкладке SQL) 
запустите из меню SQL -> Execute -> All. Успешность передачи SQL-операторов в базу сервера MN 
проверьте в нижней части вкладки SQL (log-окно).  
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12. Процедура согласования баз данных 
дублированного модуля MLC на пассивной 
стороне (Cold Stand-By)  

В программное обеспечение дублированного модуля MLC внесен дополнительный механизм, с 
помощью которого возможно полное восстановление системы данных на пассивной стороне (CSB � 
Cold Stand By) модуля. По окончанию работ, связанных с локальным вмешательством в модуль, эта 
процедура обеспечивает правильный перенос базы данных, генерируемой в процессе этих работ на 
активной стороне модуля (In Operation), на пассивную сторону Cold Stand By (например, замена диска 
на съемной плате CLC на стороне CSB) и MN. Согласование баз данных выполняется без 
прерывания работы модуля MLC, кроме незначительного прерывания трактов 2Mбит/с на пассивной 
стороне в момент установки этой стороны в состояние Installation State. Активная сторона (In 
Operation) дублированного модуля MLC в процессе работ, связанных с локальным вмешательством, 
нормально работает. Процедура согласования данных по запросу оператора по направлению к 
модулю используется в случае появления в процессе работы модуля трудностей, связанных с базой 
данных модуля MLC. Это могут быть, например, аварийные сигналы с кодами 100120, 100130, 
100140, 100150�процедура согласования проводится также, если необходимо повторно 
инсталлировать базу данных на пассивную сторону (например, повреждение файловой системы 
пассивной стороны). Механизм основан на предопределении базы данных узла управления (MN), как 
первичной и единственно правильной. Если это не так, оператор должен удовлетворить это 
требование с помощью стандартного способа согласования проблемных данных между MN и 
активной стороной (In Operation) модуля, как описано в пункте 11. 

12.1. Процедура согласования данных на пассивной стороне (CSB) 
дублированного модуля MLC по запросу оператора из MN 

Условием для начала согласования баз данных по запросу оператора является установка пассивной 
стороны модуля в состояние инсталляции (Installation State). Процедуру согласования данных по 
запросу оператора из MN на пассивную сторону модуля запустите с помощью меню SYS -> 
Administration -> Node DB Synchronisation -> Start. После активирования процедуры согласования 
данных по запросу оператора на MN производится блокирование функций администрирования, на 
активной стороне (In Operation) дублированного модуля MLC запускается некая последовательность 
действий, после успешного окончания всех этих действий вернется подтверждение запроса на 
согласование. Если действия, произведенные в соответствии с этой последовательностью на 
активной стороне дублированного модуля MLC, не будут успешным, вернется сообщение об отказе 
запроса на согласование, на узле MN снова будет активировано администрирование.  
 
События, произошедшие после активирования процедуры согласования данных на активной стороне 
дублированного модуля MLC: 
 

• останавливается перенос изменений данных между активной и пассивной сторонами модуля 
MLC; изменения, произошедшие во время процесса согласования данных, сохраняются на 
активной стороне дублированного модуля MLC; 

• останавливается перенос изменений (триггеров) из активной стороны дублированного модуля 
MLC на MN; содержимое остается на активной стороне дублированного модуля MLC, 

• старое содержимое очереди с возвратными триггерами на активной стороне дублированного 
модуля MLC правильно обрабатывается и удаляется. 
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Повторно сделайте экспорт полупостоянных данных из компьютера MN (SYS -> Administration -> 
Database -> Node Data -> Export). Полупостоянные данные, которые были экспортированы, 
перенесите на пассивную сторону модуля в соответствии со стандартной процедурой (SYS �> 
Administration -> Install-Backup -> Actions -> File Transfer ->Install). По окончанию переноса данных на 
пассивную сторону произведите сброс (reset) пассивной стороны модуля. Затем по запросу 
оператора из MN остановите процедуру согласования данных на пассивной стороне модуля с 
помощью меню SYS -> Administration -> Node DB Synchronisation -> Stop. Аварийный сигнал об ошибке 
в базе данных модуля будет снят. На активной стороне дублированного модуля MLC при установке 
параметра Node DB Synchronisation = Stop снова активируется очередь на согласование данных на 
пассивную сторону и активируется очередь триггеров на активной стороне дублированного модуля 
MLC по напрвлению к MN. Разблокируются функции администрирования компьютера MN. 
 
После использования программного инструмента для согласования данных активной и пассивной 
сторон модуля по запросу оператора, активная сторона дублированного модуля MLC будет 
производить согласование данных на пассивной стороне. 



 

 SOP6307M0-ATR-020  

 

37 

13. Инструкция по ежедневному архивированию на 
накоптеле DDS и по эксплуатации накопителя 
DDS 

Для архивирования на сервере MN находится накопитель DDS одного из двух типов. При 
архивировании на накопителе DDS-2 используется лента DDS-2 4 мм длиной 90 м. Указанный 
накопитель находится на компьютерах Compaq Desk Pro. При архивировании на накопителе DDS-3 
используется лента DDS-3 4мм длиной 125 м. Такой накопитель находится на всех серверах MN, 
работающих на платформе DELL 6300. На объекте должны быть четыре (4) ленты. Замена ленты 
производится раз в неделю. Через четыре недели снова приходит очередь ленты номер один. На 
объекте должна быть также чистящая кассета:  
 
• для накопителя DDS-2 - Packard C5709A HP DDS Cleaning Cartridge, 
• для накопителя DDS-3 - Sony DG5CL DDS 4mm Cleaning Data Cartridge Casette 
 
Ленты должны иметь соответствующие этикетки и должны храниться в специальном месте. 
 
При каждой инсталляции MN продукта устанавливается время автоматического архивирования 
данных на диск или магнитную ленту, по умолчанию предусмотренное время архивирования - 
ежедневно в 01:30 ночи. 
 
Проверка успешности проведения архивирования производится в окне аварийной сигнализации для 
MN: 
 

 
 
В окне аварийной сигнализации для MN проверьте (двукратный щелчок мышкой на значок MN) 
отсутствие аварийного сигнала для Tape Backup. 
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Если архивирование на магнитную ленту не было выполнено успешно, в поле Last Backup Return 
Code появится запись соответствующего кода ошибки на красном фоне. 
 
Результаты успешного архивирования можно проверить также в Application Log во вкладке Evens.  
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Прежде всего, это важно для записи, имеющей в поле Source отметку SysService. Записи,  связанные 
с архивированием, выделены синим цветом. 
 

 
 
 
 
 

 
Персонал по техническому обслуживанию должен выполнять на 
MN следующие действия: 
  
Перед первым использованием каждой ленты для нее делается этикетка с номером ленты (от 
1 до 4) и датой начала ее использования. Замена ленты производится через год с начала ее 
эксплуатации. Чистящую кассету необходимо использовать раз в неделю, и перед каждым 
употреблением проверять ее пригодность. Если использована вся кассета (закончена лента), 
ее обязательно заменить. Постоянное и правильное использование кассеты � основное 
условие для успешного архивирования на магнитной ленте. 
 
Для проверки успешности автоматического архивирования, выполняющегося с 01:30 ночи 
ежедневно просматривайте аварийные сигналы, относящиеся к MN. При появлении 
аварийного сигнала, выньте ленту из блока и на ее место поставьте новую, произведите 
очищение магнитной ленты (пункт 13.2). Произведите архивирование вручную (пункт 13.3.2). 
Если это не удастся, необходимо обратиться в сервисный центр Iskratel. 
 
РАЗ В НЕДЕЛЮ выньте ленту с архивными данными из блока, затем в блок вставьте 
ЧИСТЯЩУЮ КАССЕТУ, блок автоматически выполнит ее загрузку и очистку головки. После 
очистки кассета выйдет из блока автоматически. По окончанию очистки в блок установите 
ленту с архивными данными. 
 
Раз в неделю меняйте ленту на следующую. 
• Прежде всего, ленту с архивированными данными прошедшей недели выньте из блока, 

прочитайте ее содержимое (пункт 13.1), убедитесь, что архивные данные действительно на 
ней есть. На этикетке ленты напишите период, за который собраны данные. На ленте 
должны быть данные для каждого дня прошедшей недели.  

• В блок вставьте чистящую кассету, блок автоматически выполнит ее загрузку и 
очистит головку. После законченной очистки кассета будет выдана автоматически. 

 
• В блок вставьте другую ленту (со следующим порядковым номером), на которую будут 

записываться данные на следующей неделе. Произведите очистку магнитной ленты (пункт 
13.2). Tеперь лента готова для записи архивов на будущей неделе. 

 
При больших изменениях в базе данных станции, например, при администрировании 
большого количества абонентов, добавление новых маршрутов и т.д., производите также 
ручное архивирование (пункт 13.3.2).  
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13.1. Работа с магнитной лентой, считывание  

Работу с магнитной лентой обеспечивает приложение NTBackup, которое запустите из меню Start -> 
Programs -> Administrative Tools (Common) -> Backup. В открывшемся окне выберите команду 
Operations -> Catalog. Через несколько секунд откроется окно, в котором появятся все записи, 
имеющиеся на ленте: 
 

 
 

13.2. Подготовка магнитной ленты � очистка ленты 

Каждый раз, когда берете новую магнитную ленту или хотите использовать уже ранее 
пользованную ленту (не нужную более), необходимо ее очистить. Ленту вставьте в блок и 
выберите в меню Start -> Programs -> Administrative Tools (Common) -> Backup. 
Выберите команду Operations -> Erase Tape и в открывшемся окне нажмите кнопку Quick Erase и 
продолжите, нажав Continue. 
 

 
 
В окне Erase Status, в ответ на сообщение об успешном очищении ленты, нажмите OK. 
 

 

13.3. Типы архивирования  

Существует два типа архивирования, автоматический � с помощью сервиса архивирования и ручной 
� с помощью соответствующей командной строки. Ручное и автоматическое архивирование почти 
полностью идентичны, различаются только способом запуска. 
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13.3.1. Автоматическое архивирование  

При каждой инсталляции MN процедура по умолчанию устанавливает автоматическое 
архивирование данных на диск и на магнитную ленту, время архивирования по умолчанию - 
ежедневно 01:30 ночи. Если автоматическое архивирование по умолчанию удалено, 
необходимо предусмотреть все последствия.  
 
Параметры архивирования по умолчанию находятся в окне MN Configuration Settings, на вкладке 
Backup on DDS, которая открывается из меню Start -> Programs -> Management Node -> MN 
Configuration. В окне должны быть подтверждены поля Enable Backup, которое позволяет создание 
резервной копии и Enable Backup on DDS, позволяющее сохранение резервной копии на магнитной 
ленте. В нижней части вкладки находится лист расписания резервного копирования. Лист содержит 
следующие данные:  
 
• Level � уровень архивирования, обычно имеет значение 0,  
• Backup Days � дни недели для выполнения архивирования, по умолчанию � это все дни недели,  
• Backup Times � время архивирования, значение по умолчанию - 1:30 ночи. 

 
 

13.3.2. Архивирование вручную  

Для архивирования вручную выберите в меню Start -> Programs -> Management Node -> MN 
Configuration и вкладку Backup. Нажмите кнопку MN Backup Commands, после чего откроется окно MN 
Backup Options. Выберите в нем Backup on demand, в следующем открывшемся окне выберите 
нулевой уровень архивирования базы данных, и подтвердите нажатием OK. 
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Процедура архивирования может длиться от 15 минут и более часа, в зависимости от количества 
данных в базе и в файловой системе. Во время архивирования на MN невозможно выполнять 
некоторые операции в связи с тем, что некоторые сервисные приложения в данный момент являются 
неактивными, поэтому архивирование целесообразно выполнять в то время, когда не планируется 
производить администрирования или других дел. 
 
При успешном создании резервной копии, в заключение откроется следующее окно 
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14. Инструкция по управлению записями подробных 
данных вызовов  

В базе данных находятся таблицы phone_call_1 и phone_call_2, в которые записываются подробные 
данные о вызовах. Новые данные всегда записываются в таблицу phone_call_1. Перед вводом новых 
данных проверьте наличие свободного места в таблице. Если свободного места меньше, чем 
необходимо, в нее вводятся новые записи. Если таблица больше предусматриваемого 
максимального количества записей, то, прежде всего, очищается существующая таблица 
phone_call_2 (данные в этом случае теряются). Таблица phone_call_1 преобразуется в phone_call_2, 
после чего снова создается пустая таблица phone_call_1, в которую можно начинать вводить новые 
записи. 
 
Пользователь будет оповещен при достижении 50%, 80% или 90% уровня от разрешенного значения 
заполнения базы. Например, сообщение о достижении 80-процентного уровня от разрешенного 
максимального значения, будет иметь следующий вид: 
 

80% of max charge records limit exceeded.  
Export charge records from data base otherwise  

400.286 records 
will be deleted. 

 
Для правильной работы тарифной подсистемы и для обеспечения защиты данных вызовов 
необходимо регулярно проводить архивирование, благодаря чему будет обеспечено свободное 
место для записи новых данных. С помощью команды Unload and Delete записи удаляются из базы и 
сохраняются только в файле на директории c:\si2000\files\store.  
 
Для обеспечения безопасности файлов, содержащих архивированные записи 
подробных данных вызовов, персонал по техническому обслуживанию на MN 
сразу после предыдущей процедуры должен произвести также копирование 
файлов на DDS, как описано в пункте 14.1 этого документа. 
 
На объекте должна быть хотя бы одна DDS-3 4 мм лента длиной 125 м или DDS-2 лента 4 мм длиной 
90 м, на которой будет четко указано, что эта лента предназанчается только для файлов с записями 
подробных данных вызовов.  

14.1. Архивирование записей 

Процедуру архивирования записей выполняйте каждый месяц во время снятия показаний счетчиков. 
Архивирование необходимо выполнять при входе в систему через MN будет получено сообщение о 
достижении 80 % уровня заполненности базы или исходя из собственнного опыта, примерно зная, на 
сколько времени хватает ее емкости. Архивирование можно также выполнять и при более низком 
уровне заполненности базы. 
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Прежде всего перенесите данные из базы в архивный файл типа .unl с помощью команды AMG -> File 
-> Unload and Delete. В поле даты всегда отображается текущая дата, например, 10.1.2004. Таким 
образом, из базы удаляются и переносятся в файл все записи, произведенные до 24 часов 
предыдущего дня, т.е. в данном случае до 24 часов 9.1.2004. Дату можно изменить на один день 
вперед (если необходимо удалить данные всех вызовов, установленных до момента выполнения 
данного действия) или назад (если необходимо организовать данные по неделям или месяцам). В 
каждом случае необходимо сохранить таким образом данные, которые были удалены из базы на 
ленту (DDS) с помощью следующих действий. 
 
Сразу после выполнения вышеописанной команды проведите копирование нового файла, 
содержащего записи на DDS. Из накопителя DDS достаньте ленту, на которой архивируются 
ежедневные записи, и вместо нее вставьте ленту, на которой сохраняются файлы с записями 
подробных данных вызовов. 
 
Откройте окно AMG -> File -> Store, в поле Select нажмите кнопку Archive и выберите 
соответствующий способ записи на ленту: 
 

• Add to DDS (выбранные файлы записываются на ленту к существующим файлам) 
• Create to DDS (выполняется форматирование (очищение) ленты, выбранный файл записывается 
на свободную ленту). 
В поле File выберите соответствующий файл или несколько файлов (с помощью Ctrl или Shift) и в 
поле backup description введите имя набора, например, для определенного месяца. Это имя 
выводится в Backup интерфейсе в качестве последнего поля отдельной записи. После 
завершения записи на ленте закройте окно Store нажатием Cancel. 

 
Когда процесс записи на ленту закончен, выньте ленту из накопителя и сохраните ее в определенном 
месте. В блок DDS опять установите ленту, на которой ежедневно будет записываться архив 
(автоматическое резервное копирование). 

14.2. Восстановление архивированных записей 

Администратор может просматривать и обрабатывать текущие данные, которые на тот момент 
находятся в базе данных, а также данные, которые были архивированы с помощью команды Unload 
and Delete на директории c:\si2000\files\store или с помощью команды Store на DDS магнитной ленте.  
 
Данные, архивированные с помощью команды Unload and Delete и все еще находящиеся на 
директории c:\si2000\files\store, можно с помощью команды AMG -> File -> Load перенести во 
временную таблицу в базе данных. Для обновления списка файлов используйте кнопку Refresh. 
Данные можно просмотреть через View -> Archive Calls. 
 
Данные, архивированные с помощью команды Store на DDS-ленту, прежде всего с помощью команды 
AMG -> File -> Restore необходимо скопировать с ленты на диск. В поле Archive Utility выберите 
NTTAR, если записи на ленте DDS были созданы с помощью приложения nttar или NTBACKUP, если 
записи были записаны с помощью приложения ntbackup. 
 
Если были выбраны NTTAR и Apply, будут выведены файлы, находящиеся на магнитной ленте. 
Выберите соответствующий файл и скопируйте его на диск. После этого записи из выбранного файла 
с помощью команды AMG -> File -> Load перенесите во временную таблицу в базе данных. Теперь 
данные можете просмотреть с помощью View -> Archive Calls. 
 
Если был выбран NTBACKUP и Apply, прежде всего появится диалоговое окно с сообщением, которое 
нужно подтвердить. 
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В окне Backup выберите Operations -> Catalog. В окне Tapes откроются все наборы записей, 
имеющихся на магнитной ленте. Выберите соответствующий набор (группу файлов за определенный 
месяц) и при двукратном щелчке появится древовидная структура поддиректориев, с помощью 
которой найдите желаемый файл. Когда его найдете, в списке на правой стороне окна пометьте его 
крестиком и выберите Operations -> Restore.  
 

 
 
 
 
Откроется следующее окно, установки параметров в котором подтвердите нажатием на OK. 
 

 
 
 
Когда в окне Restore status получите сообщение об успешном окончании процедуры, закройте окно, 
нажав OK. 
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В конце закройте интерфейс NTBackup, после чего произойдет возврат в начальное окно, его тоже 
закройте, нажав Cancel.  
 
После этого записи из выбранных файлов с помощью меню AMG -> File -> Load перенесите во 
временную таблицу в базе данных. Теперь данные можно просмотреть, открыв View -> Archive Calls. 
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